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What’s new in Word 2007 
 

1- Word2007 Interface 

 

Figure 1. Ribbon 

Word 2007 interface has changed from the previous versions. The menus and toolbars are now 
replaced with the Ribbon (see Figure 1). 

The Ribbon is designed so that all the commands needed to complete a task can be easily found. 
Commands are organized in logical groups which are collected together under tabs. Each tab groups 
related commands together. Groups within the tabs show related items together. 

Some groups have a small diagonal arrow in the lower-right corner like the one show in the Font 
group in Figure 1. This arrow is called the Dialog Box Launcher. It shows more options related to the 
feature it is next to. It launches familiar dialog boxes that were in older versions of MS Word. 

Some tabs appear as needed such as the tab for pictures. When you insert a picture and click on it, 
then the picture tab appears. 

The ribbon can be hidden temporarily be double clicking to the active tab. The groups disappear 
creating more room (as shown in Figure 2).  Double clicking again on the tab reverses this operation 
and the ribbon reappears.  

 

Figure 2. No Ribbon 

 

2- XML Files 

The new Word document file format is based on the new Office Open XML Formats. This helps 
makes the document file size smaller, safer and the document less susceptible to damage. 

3- SmartArt  

SmartArt helps create more visual representations of information. It can be easily created by 
choosing from among many different layouts. 
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4- Draw Tables 

This feature facilitates drawing complex tables for examples tables that contain cells of different 
heights or a varying number of rows. The pointer changes to a pencil and the user then draws the 
borders of the tables and then the columns and the rows inside the rectangle. To erase a line or 
block of lines, there is the eraser tool that makes it easy to erase unwanted lines or cells. 

5- Contextual spelling 

This new feature checks for spelling mistakes such as: I will see you their instead of there. A blue line 
will appear to indicate the error (as shown in Figure 3) 

 

Figure 3. Contextual spelling 

6- Citations 

Word makes it easier to cite the sources and not have to worry about the different styles. By 

choosing different styles, Word will automatically reformat the citation and the bibliography. 

7- Math equations 

The new equation writing feature in Word 2007 makes it easy to insert professionally formatted 

formulas and equations into your document. 

 

Using Templates 
To create a file using a template: 

1. Click on the Office Button 

2. Click on New 

3. Select one of the categories on the left in the open dialog  

4. Select the required template and download it 

5. The document will open and you will be able to use it 
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Saving a file in pdf format 

 

Figure 4. Save As Dialog 

 
To save in pdf format, follow the following steps: 

1. Install the Publish as PDF or XPS add-in for the 2007 Microsoft Office System.  This step is done 
once only. 

2.  Go to the Save As menu which will look like the one shown in Figure 4.  
3. Click on the arrow next to Save As. 
4. Next click on PDF or XPS.  

  



 

6 
 

Document Properties 
Document properties is also known as metadata i.e. data that describes other data. Such data includes 

the author, title, keywords etc. To set the document properties: 

1. Click on the Office Button 

2. Click on Prepare 

3. Click Properties 

4. Fill in the fields as required (as shown in Figure 5) 

 

 

Figure 5. Document Properties 

Auto Correct 
This feature is used to correct typos and misspelled words as well as to insert symbols and other pieces 

of text. The default is a list of typical misspellings and symbols but this list can be modified. If for 

example, you frequently type AUC as ACU, this can be added to the predefined list. To do so: 

1. Click on the Office Button 

2. Click on Word Options 

3. Select Proofing  

4. Click on Auto Correct Options 

5. Make sure the Replace text as you type is checked 
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Figure 6. Autocorrect dialog 

6. In the Replace field type ACU 

7. In the With field type AUC 

8. Click on Add 

9. Click on OK 

From the same dialog 

1. In the Replace field type * AUC   

2. In the With field type American University in Cairo  

3. Click on Add 

4. Click on OK 

Now every time you need to write the university name in full, simply type *AUC and word will replace it 

with American University in Cairo.  
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Collaboration 
This is a system of sharing documents and editing, tracking and reviewing the changes made. These 

changes can include insertions, deletions and formatting changes.  

To change user id: 

1. Click on Review Tab 

2. Click on Track Changes 

3. Click on Change User Name 

4. Enter your user name and initials in Personalize your copy of MS Office 

5. Click on OK 

To begin tracking: 

1. Click on Review Tab 

2. Click on Track Changes 

3. Click on Track Changes. This is now highlighted and all changes will be tracked. 

Changes are shown as follows: Insertions are underlined, deletions are striked through, and changed 

lines have an outside border. Each change is color coded according to the user’s color. 

To insert a comment, click on New Comment from the Comments group. Type in the comment and click 

back inside the document when done. 

To review changes: 

1. Turn off tracking by clicking on the Track Changes button to toggle it off. 

2. From the changes group, click on Next and Previous to navigate through the different changes 

made in the document. 

3. To accept the change, click on Accept. The default setting is that Word will move to the next 

change. 

4. To reject the change, Click on Reject. 

 

Once all changes are reviewed, the review marks are removed and the document will look like it did 

when it was first created. 

Cross References 
This is a way to help readers navigate through the document like locating figures, tables and equations. 

Each one of these items must have a caption first. To create a caption: 

1. After inserting the figure, table or equation, move the pointer inside the image and right click 

2. Click on Insert Caption to launch the dialog shown in Figure 7 

3. Type in the caption title 
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4. Select the correct setting from options i.e. select whether the label is for a table, a figure or an 

equation 

5. Select the position of the caption 

6. Click on OK 

 

 

Figure 7. Caption dialog 

Once the caption has been created, the cross reference can now be created. To do so: 

1. Click on Insert Tab from the ribbon 

2. Click on Cross-reference from the Links group to launch the dialog shown in Figure 8 

3. Select the Reference Type 

4. Check on Insert as hyperlink 

5. Select which dialog you are referencing from the For which caption list 

6. Select the method of referencing from Insert reference to.  The options are shown in Figure 8 

7. Next click on Insert. 
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Figure 8. Cross-reference dialog 

Every time a new caption is inserted MS Word automatically adjusts the numbering. To adjust the cross-

references simply select the whole document and press F9. To use the cross reference, move the mouse 

pointer into the cross-link and press CTRL and click on the link. 

Equation Editor 
The equation editor helps is a new feature in word 2007. It has predefined equations to choose from or 

you can type in your own equation. To do so: 

1. From the Insert tab, click on Equation in the Symbols group 

2. Select from the existing predefined equations 

3. OR  click ok Insert New equation 

4. Select the required equation 

5. Insert the numbers accordingly 

Table of Contents 
To create a table of contents: 

1. Go to the page where you want to insert the Table of Contents (TOC) 

2. Go to the References Tab 

3. Click on Table of Contents 

4. Select a style and MS Word will create a 3-level TOC. 
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Another way to create the TOC is to follow the above steps and in step 4 click on Insert Table of 

Contents to launch the dialog shown in Figure 9. From this dialog, you can control the number of levels 

shown in the TOC.  

 

 
Figure 9. Table of Contents 

To update the TOC, right click inside it and the following appears (as shown in Figure 10). Click on 

Update Table and select from the options shown. 

 

Figure 10. Update Table of Contents 
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Table of Figures 
Similarly, you can create a table to list all the figures that appear in the document. To create a table of 

figures: 

1. Go to the page where you want to insert the Table of Figures 

2. Go to the References Tab 

3. From the Captions group, Click on Insert Table of Figures 

4. This will launch a dialog, select the settings required. 

5. Click on OK  

Password Protection 
Password protection prevents anyone without the given password from opening and reading the 

document. To create a password: 

1. Click on the Office Button 

2. Click on Save As and select the format to save the document 

3. Click on the Tools button on the bottom left of the Save As dialog 

4. Select General Options 

5. In the fields Password to Open and Password for modifying (as shown in Figure 11), type in the 

same password 

6. For more options click on the Protect Document button. This will show the list of available 

editing options on the right-hand side of the document. 

7. Click Save 

To open the document from this point, MS Word will prompt for the password. 
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Figure 11. General Options dialog 

Watermarks 
Watermarks are text or pictures that appear behind document text. Word 2007 has some galleries of 

predefined watermarks or you can create your own. To create a water mark: 

1. Click on Page Layout tab 

2. From the Page Background group click Watermark 

3. Select one of the predefined watermarks 

4. OR Select Custom watermark to launch the dialog shown in Figure 12 

5. For a picture watermark, select the Picture watermark option 

6. Select the required picture and click Apply 

7. Next, click on OK 

8. To create a text water mark, select the text watermark option 

9. Select the language, the text to show in the watermark and set the remaining options 

10. Click Apply and next click on OK 
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Figure 12. Custom Watermark 

 

Watermarks can be viewed only in Print Layout and Full Screen Reading views and on the printed page. 

MACROS 
 

A macro is a series of commands and instructions that you group together as a single command to 

accomplish a task automatically. Macros are very good to use but you must be very specific with them. 

Typical uses for macros are: 

 To speed up routine editing and formatting  

 To combine multiple commands — for example, to insert a table with a specific size and 

borders, and with a specific number of rows and columns  

 To make an option in a dialog box more accessible  

 To automate a complex series of tasks  

An example macro is one that selects all text and updates the fields. To create this macro : 

1. Go to the View tab 

2. From Macro group, click on Macros 

3. Click on Record Macro to display the figure shown in Figure 13 

4. Type in a name for the macro in Macro name and its description in the field Description 

5. Click on OK to start recording 

6. Press CTRL + A 



 

15 
 

7. Press F9 

8. Press CTRL + Home 

9. Click Stop Recording 

 

 

Figure 13. Record Macro 
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Useful Links 
 

 Microsoft Office Online Training Home Page 

http://office.microsoft.com/en-us/training/default.aspx 

 

 Interactive Word 2003 to Word 2007 command reference guide 

http://office.microsoft.com/en-us/word/HA100744321033.aspx 




